You also can display a single workbook in more than one window. For example, if
you have a warkbook with two worksheets, you may want to display each worksheet
in a separate window. All the window-manipulation procedures described previously
still apply.

Closing Windows

When you cloge a workbook window, Excel checks whether you have made any
changes sincq the last time you saved the file. If not, the window closes without
a prompt from Excel. If you've made any changes, Excel prompts you to save the
file, before it ¢loses the window.

You learr) more about working with files in Chapter 5.

To close a wiridow, simply click the Close button on the title bar.

Mouseless Window Manipulation

Although usirlg a mouse to manipulate Excel’s windows is usually the most efficient
route, you alspo can perform these actions by using the keyboard. Table 4-1 summa-
rizes the key ombinations that manipulate workbook windows.

Ctrl+Shift+F6

g B : s

Maximize a window
‘ )

T i

e S ) A L i

* Use the direction keys to make the change, and then press Enter.
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Moving Around a Worksheet

You'll be spending a lot of time moving around your worksheets, sp it pays to learn
all the tricks.

Every worksheet consists of rows (numbered 1 through 65,536) gnd columns
(labeled A through IV). After column Z comes column AA; after cplumn AZ comes
column BA, and so on. The intersection of a row and a column is|a single cell. At
any given time, one cell is the active cell. You can identify the actiive cell by its
darker border, as shown in Figure 4-4. Its address (its column letter and row num-
ber) appears in the Name box. Depending on the technique that you use to navi-
gate through a workbook, you may or may not change the activecell when you
navigate.

The row and column headings of the active cell are displayed in bpld — making it
easy to identify the active cell.

The active cell

scel - Book

Figure 4-4: The active cell is the cell with the dark border; in this cas¢




How Big Is a Worksheet?

Using the|Keyboard

As you probably already know, you can use the standard navigational keys on your
keyboard to meve around a worksheet. These keys work just as you would expect:
the down arroy moves the active cell down one row, the right arrow moves it one
column to the fight, and so on. PgUp and PgDn move the active cell up or down
one full window (the actual number of rows moved depends on the number of rows
displayed in the window).

turn on Scroll Lock, you can scroll through the worksheet without

Lock and fthen use the direction keys to scroll through the worksheet. When you
want to rgturn to the original position (the active cell), press Ctrl+Backspace. Then,
press Scroll Lock again to turn it off. When Scroll Lock is turned on, Excel displays
SCRL in tthe status bar at the bottom of the window.

The Num Locl key on your keyboard controls how the keys on the numeric keypad
behave. When|Num Lock is on, Excel displays NUM in the status bar, and the keys
on your numefic keypad generate numbers. Most keyboards have a separate set of
navigational keys located to the left of the numeric keypad. These keys are not
affected by th¢ state of the Num Lock key.

Table 4-2 suminarizes all the worksheet movement keys available in Excel.
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* With Scroll Lock on

The actions for some of the keys in the preceding table may be differept, depending on
the transition options that you've set. Select Tools = Options and ther] click the
Transition tab in the Options dialog box. If the Transition Navigation Keys option is
checked, the navigation keys correspond to those used in older versi¢ns of Lotus 1-2-3.
Generally, using the standard Excel navigation keys is better than usirg those for 1-2-3.

If you know either the cell address or the name of the cell that ypu want to acti-
vate, you can get there quickly by pressing F5 (the shortcut key for Edit=> Go To).
This command displays the Go To dialog box.

Just enter the cell address in the Reference box (or choose a narrHed cell from the
list), press Enter, and you're there.

Using a Mouse

Navigating through a worksheet with a mouse also works as you would expect it to
work. To change the active cell by using the mouse, click another pell; it becomes
the active cell. If the cell that you want to activate is not visible injthe workbook '
window, you can use the scrollbars to scroll the window in any difection. To scroll
one cell, click either of the arrows on the scrollbar. To scroll by a fomplete screen,
click either side of the scrollbar’s scroll box. You also can drag th¢ scroll box for
faster scrolling. Working with the scrollbars is more difficult to degcribe than to do,




so if scrollbars

are new to you, I urge you to experiment with them for a few

minutes. You'lllhave it figured out in no time.

When you drag

the scrollbar’s scroll box, a small yellow box appears that tells you

which row or golumn you will scroll to when you release the mouse button.

If you have a Microsoft IntelliMouse (or a compatible wheel MOUse), you can use

the mouse whdel to scroll vertically. The wheel scrolls three lines per click at the

default rate. Al

0, if you click the wheel and move the mouse in any direction, the

worksheet scr¢lls automatically in that direction. The more you move the mouse,
the faster the scrolling. If you prefer to use the mouse wheel to zoom the work-
sheet, select Tpols = Options, click the General tab, and then place a check mark
next to the optjon labeled Zoom on roll with IntelliMouse.

Using the scrollbars or scrolling with the IntelliMouse doesn’t change the active
cell. It simply gcrolls the worksheet. To change the active cell, you must click a new
cell after scrolling.

Notice that onjy the active workbook window has scrollbars. When you activate

a different wi

Excel is desig

ow, the scrollbars appear.

Giving Commands to Excel

d to take orders from you. You give these orders by issuing

commands. You can give commands to Excel by using the following methods:

4 Menus

4 Shortcut|menus

4 Toolbar puttons

4 Shortcut|key combinations

In many casesLyou can choose how to issue a particular command. For example,

if you want to
command), a §
a toolbar butt
combination (|

The following

ave your workbook to disk, you can use the menu (the File= Save
thortcut menu (right-click the workbook’s title bar and click Save),
bn (the Save button on the Standard toolbar), or a shortcut key
Ctrl+S). The particular method you use is up to you.

sections provide an overview of the four methods of issuing com-

mands to Excel.

Using Excel’s Menus

Excel, like all other Windows programs, has a menu bar located directly below the title
bar (see Figurq 4-5). This menu bar is always available and ready for your command.
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Excel’'s menus change, depending on what you're doing. For example, if yqu’re working
with a chart, Excel's menus change to give you options that are appropriate for a
chart. This all happens automatically, so you don’t even have to think abdut it.

Figure 4-5: Excel's menu bar displays different options, depending on the n3
of your task.

Technically, Excel 2000’s menu bar is just another toolbar. In Excel 2040, toolbars
and menu bars are functionally identical. However I'll continue to discuss menu
bars as if they are something different.

Using a Mouse

Opening the menu with a mouse is quite straightforward. Click the merju that you
want to open and it drops down to display menu items, also called commands, as
shown in Figure 4-6. Click the menu item to issue the command.

Figure 4-6: Opening E:JF
Edit menu displays
its menu items.




Typing 'S4
Bold

. Typing "Amount” in &1
Insert Cells
ing "788"

Some menu ite

s lead to an additional submenu; when you click the menu item, the
submenu appedrs to its right. Menu items that have a submenu display a small
triangle. For example, the Edit = Clear command has a submenu, shown in Figure

4-7. Excel's designers incorporated submenus primarily to keep the menus from
becoming too léngthy and overwhelming to users.
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Some menu items also have shortcut keys associated with them. The ones that do
usually display the key combination next to the menu item. For example, the Edit=>
Find command’s shortcut key combination is Ctrl+F.

Figure 4-7: The submenu of the Edit= Clear
command.

Sometimes, you'll notice that a menu item appears grayed out. Thig simply means
that the menu item isn’t appropriate for what you're doing. Nothinig happens if you

select such a menu item.

Menu items that are followed by an ellipsis (three dots) always difplay a dialog
box. Menu commands that don't have an ellipsis are executed immediately. For
example, the Insert = Cells command results in a dialog box, becalise Excel needs
more information about the command. The Insert = Rows comm d doesn't need
a dialog box, so Excel performs this command immediately.




In Excel 2D00, your menus may behave differently than they did in previous ver-
sions of Excel. When you open a menu, you may see the most recently used com-
mands first. After a few moments, or if you click the arrow at the bottom of the
menu, yoi'll see the rest of the commands for that menu. After you choose a com-
| mand by dlicking the arrow at the bottom of the menu, Excel leaves that command
4 in the list]of “recently used” commands; that is, you'll see it immediately among
' the availaple commands the next time that you open the menu. To find it again,

you won'ti need to click the arrow at the bottom of the menu or wait until all the
ds appear.

, | think this “automatic menu customization” is one of the worst ideas
ever — ard is practically guaranteed to cause confusion among beginners. | highly
recommend that you turn this feature off immediately. Choose Tools = Customize
and click |the Options tab. Then, remove the check from the check box titled
Menus shpw recently used commands first (see Figure 4-8). Note: Changing this
behavior in Excel changes the behavior for all Office applications.

: Change menu behavior to show
all commands by clearing this check box.

Using the|Keyboard

You can issue jnenu commands by using the mouse or the keyboard. Although
most users tend to prefer a mouse, others find that accessing the menus with the
keyboard is m¢re efficient. This is especially true if you're entering data into a
worksheet. Using a mouse means that you have to move your hand from the key-
board, locate the mouse, move it, click it, and then move your hand back to the
keyboard. Althpugh this takes only a few seconds, those seconds add up.
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To issue a menu command from the keyboard, press Alt and then the fnenu’s Aot
key. The hot key is the underlined letter in the menu; for example E is fthe hot key of

the Edit menu. After you open the menu, you can press the appropriatfe
a command on the menu. For example, to issue the Data > Sort comm|
press D, and then press S.

hot key for
d, press Alf,

You also can press Alt alone, or F10. This selects the first menu (the File menu).
Next, you use the direction keys to highlight the menu that you want, and then
press Enter. In the menu, use the direction keys to choose the appropriate menu

item, and press Enter again.

Moving the Menu

In Excel 2000, a menu bar is the same as a toolbar. Because the menu bdr is a toolbar,
you can move the menu to a new location, if you prefer. To move the mé¢nu, just click
and drag it to its new location. This can be a bit tricky, because you must click the
menu in a location that doesn’t contain a menu item, such as to the right of the Help
menu. You can drag the menu to any of the window borders or leave it free-floating,
Figure 4-9 shows the menu after relocating it to the left side of the winddw.

Figure 4-9: You can move Excel's menu to a new location.




Learn hojw to customize Excel's menus (and toolbars) in Chapter 33.

Using Shartcut Menus

Besides the omnipresent menu bar, discussed in the preceding section, Excel features
a slew of shorjcut menus. A shortcut menu is context-sensitive —its contents depend
on what you're doing at the time. Shortcut menus don’t contain all the relevant com-
mands, just those that are most commonly used for whatever is selected. You can dis-
play a shortciit menu by right-clicking just about anything in Excel.

As an exampl, examine Figure 4-10, which shows the shortcut menu (also called a
context menu) that appears when you right-click a cell. The shortcut menu appears
at the mouse{pointer position, which makes selecting a command fast and efficient.

Figure 4-10: [Right-clicking a cell displays this shortcut menu.

The shortcuf menu that appears depends on what is currently selected. For example,
if you're working with a chart, the shortcut menu that appears when you right-click a
chart part cgntains commands that are pertinent to what is selected.
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Instant Help for Commands

Ernt

Although shortcut menus were invented with mouse users in mind, you also can
display a shortcut menu by pressing Shift+F10.

Excel’s Toolbars

Excel, like all leading applications, includes convenient graphical toglbars, Clicking
a button on a toolbar is just another way of issuing commands to Excel. In many
cases, a toolbar button is simply a substitute for a menu command. For example,
the Copy button is a substitute for Edit=> Copy. Some toolbar buttois, however,
don’t have any menu equivalent. One example is the AutoSum button, which auto-
matically inserts a formula to calculate the sum of a range of celis. Toolbars can be
customized to include menu commands as well as buttons.

By default, Excel displays two toolbars (named Standard and Formaiting). Techni-
cally, it displays three toolbars, because the menu bar is actually a foolbar named
Worksheet menu bar. All told, Excel 2000 has 23 built-in toolbars, plds the menu bar.
You have complete control over which toolbars are displayed and where they are
located. In addition, you can create custom toolbars, made up of b
find most useful.




In Excel 2

bar; Exce

D00, the Standard and Formatting toolbars may appear side by side just

below the menu bar. In prior versions, these toolbars appeared separately.
Because the toolbars appear side by side, you can't see all the tools on either tool-

displays those tools on each toolbar that you are most likely to use

frequently. If you want to use one of the “missing tools,” you must click the arrow

toolbar (

of Excel

is hidden

that appefars at the edge of the toolbar to display all the tools available on that

e Figure 4-11). After you choose a tool from the “missing tools,” Excel

continueq to display that tool, because you recently used it.

If you prefer to see all the tools on a toolbar, you can drag one of the toolbars to a
different focation. If you want to display one below the other (as previous versions

id), drag one below the other or choose Tools=> Customize. Click the

Options tab and remove the check from the check box labeled Standard and
Formattirlg toolbars share one row. This check box is not available if either toolbar

or both toolbars are floating (you'll learn more about “floating toolbars”

later in this chapter). Changing this behavior in Excel affects only Excel.

Click here

Figure -

11: Click the arrow to display more tools on the Standard toolbar.
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Table 4-3 lists all of Excel’s built-in toolbars.

Tools to copy and paste multiple Clipboard selections Hetween
Office applications
“\Yég&,

Obtain assistance in identifying circular references in fgrmulas

Shadow Settings

/
%i The Clipboard toolbar (and the way the Clipboard functions in Office 2400 appli-
cations) is new in Excel 2000.




See Chapter 8 for more information on the Clipboard.

Sometimes, Hxcel automatically pops up a toolbar to help you with a particular
task. For example, if you're working with a chart, Excel displays its Chart toolbar.

Hiding or Showing Toolbars

To hide or display a particular toolbar, choose View= Toolbars, or right-click any
toolbar. Eithgr of these actions displays a list of common toolbars (but not all
toolbars). The toolbars that have a check mark next to them are currently visible.

To hide a todlbar, click it to remove the check mark. To display a toolbar, click it to
add a check mark.

If the toolbay that you want to hide or show does not appear on the menu list,
select View o Toolbars = Customize (or select Customize from the shortcut menu
that appears|when you right-click a toolbar). Excel displays its Customize dialog
box, shown ip Figure 4-12. The Toolbars tab of this dialog box shows a list of all
toolbars tha{ are available — the built-in toolbars, plus any custom toolbars.

. The toolbarg that have a check mark next to them are currently visible. To hide
a toolbar, clitk it to remove the check mark. To display a toolbar, click it to add
a check mark. When you're finished, click the Close button.

Figure 4-12: [hoose which toolbars to
display in the |Customize dialog box.

The Customijze dialog box has some other options with which you may want to
experiment. Click the Options tab to display these options (see Figure 4-13). The
check boxes|at the top of the Options tab were discussed earlier in the chapter.
The button labeled Reset my usage data, in the middle of Figure 4-13, works in
conjunction with the check box titled Menus show recently used commands first.
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Excel determines the commands to show based on the commands th

most often. Clicking the Reset my usage data tells Excel to ignore your past usage
and reset the menu commands to the defaults that shipped with the product. If
you leave the check in the Menus show recently used commands first

after resetting usage, Excel starts the “monitoring” process over agai
mine which commands you're using most often.

Figure 4-13: The Options tab of the Customize
dialog box provides some options for toolbars.

Chapter 33 discusses the Commands tab of the Customize dialog box.

is useful, but it also slows things down quite a bit. For a faster font list, r
check from the check box titled List font names in their font. And if you
pop-up screen tips distracting, uncheck the Show ScreenTips on toolbar:
You can also specify what type of animation you prefer for the menus.

Moving Toolbars

Toolbars can be moved to any of the four sides of Excel’s window, or c:
floating. A free-floating toolbar can be dragged onscreen anywhere that

You also can change a toolbar’s size simply by dragging any of its bord
a free-floating toolbar, click its Close button.

Because Excel 2000 menu bars are actually toolbars, this discussion als
the menu bars.

If you prefer larger buttons, check the Large icons check box. By default,
open the Font list box, font names provide a sample of the font (see Figt}'e 4-14). This

you use

check box
to deter-

n

when you

move the
nd those
s check box.

in be free-
you want.
Frs. To hide

o applies to




Figure 4-14: By default,
When a tgolbar isn’t free-floating, it's said to be docked. A docked toolbar is stuck to

the edge ¢f Excel’s window and doesn’t have a title bar. Therefore, a docked toolbar
can’t be resized.

To move p toolbar (docked or free-floating), click and drag anywhere on the back-
ground of the toolbar (that is, anywhere except on a button). When you drag it
toward the window's edge, it automatically docks itself there. When a toolbar is
docked, ifs shape changes to a single row or single column.

Learning More About Toolbars

Describirg all the toolbar buttons available would take many pages, so I won’t
even try.|You are charged with discovering this handy feature on your own. But,
throughqut the rest of the book, I point out toolbar buttons that may be useful in
particulay situations.

Chapter 33 discusses toolbars in more detail, including how to customize toolbars.
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Working with Dialog Boxes

As previously stated, menu items that end with an ellipsis (three dots) reqult in a

Shortcut Keys

This chapter mentioned earlier that some menu commands have equivalent shortcut
keys. Usually, the shortcut key combination is displayed next to the menu ifemn —
providing a built-in way for you to learn the shortcuts as you select the con

Throughout the book, shortcut keys are examined that are relevant to any
lar topic.

Appendix C lists all the shortcut keys available in Excel.

dialog box. All Windows programs use dialog boxes, so you may already b
with the concept.

About Dialog Boxes

mands.

particu-

e familiar

You can think of a dialog box as Excel’s way of getting more information f

about the command that you selected. For example, if you choose View={Zoom
(which changes the magnification of the worksheet), Excel can’t carry ouf the com-

mand until it finds out from you what magnification level you want. Dialog
can be simple or much more complicated. Dialog boxes are made up of se
items, known as controls.

When a dialog box appears in response to your command, you make ad
choices in the dialog box by manipulating the controls. When you're fin
click the OK button (or press Enter) to continue. If you change your mi
the Cancel button (or press Escape) and nothing further happens —it’s
dialog box never appeared.

If a dialog box obscures an area of your worksheet that you need to see
click the dialog box’s title bar and drag the box to another location. The
in a dialog box has two controls: a Help button (Question-mark icon) an
button. When you click the Help button, the mouse pointer displays a q

pressing Escape.

Although a dialog box looks like just another window, it works a little diff
When a dialog box appears, you can’t do anything in the workbook until
box is closed. In other words, you must dismiss the dialog box before yo
anything.

d, click

1 a Close
1estion
mark. You can click any part of the dialog box to get a description of thdt part’s
purpose. Clicking the Close button is the same as clicking the Cancel button or

erently.

I

m you

boxes
eral

itional
hed,
if the

simply
title bar

e dialog
an do




Dialog|Box Controls

Most people find working with dialog boxes to be quite straightforward and natural.
The contrgls usually work just as you would expect, and they can be manipulated
either with your mouse or directly from the keyboard.

The following sections describe the most common dialog box controls and show
some exarhples.

Buttons

A button cpntrol is about as simple as it gets. Just click it and it does its thing. Most
dialog boxes have at least two buttons. The OK button closes the dialog box and
executes the command. The Cancel button closes the dialog box without making any

changes. If an ellipsis appears after the text on a button, clicking the button leads to
another diplog box.

Pressing the Alt key and the button’s underlined letter is equivalent to clicking the
button. Pressing Enter is the same as clicking the OK button, and pressing Esc is
the same 3s clicking the Cancel button.

Option buttons

Option buftons are sometimes known as radio buttons, because they work like the
preset station buttons on an old-fashioned car radio. Like these car radios, only
one option button at a time can be “pressed.” Choosing an option button is like
choosing 4 single item on a computerized multiple-choice test. When you click an
option button, the previously selected option button is unselected.

Option buftons usually are enclosed in a group box, and a single dialog box can

have several sets of option buttons. Figure 4-15 shows an example of a dialog box
with option buttons.
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Figure 4-15: This dialog
box has seven option
buttons.

Check boxes

A check box control is used to indicate whether an option is on or off.
to responding to an item on a True/False test. Figure 4-16 shows a dialg
several check boxes. Unlike option buttons, each check box is indepen
others. Clicking a check box toggles on and off the check mark.

Figure 4-16: An example of check boxes in
a dialog box.

Range selection boxes

This is similar
g box with
dent of the

A range selection box enables you to specify a worksheet range by d
the worksheet. A range selection box has a small button that, when clicked, col-

lapses the dialog box, to make it easier for you to select the range by
the worksheet. After you select the range, click the button again to r

gging inside

ragging in
tore the

dialog box. Figure 4-17 shows a dialog box with two range selection bbx controls.

The control in the middle is a standard edit box.

Spinners

A spinner control makes specifying a number easy. You can click the arrows to
increment or decrement the displayed value. A spinner is almost always paired
with an edit box. You can either enter the value directly into the edit/box or use

the spinner to change it to the desired value. Figure 4-18 shows a dial
several spinner controls.

og box with




Figure 4-17: A range selection
box enables you to specify a

: worksheet range by dragging
=s===—=sel in the worksheet.

Figure 4-1§: This dialog box has several spinner controls.

List boxe

A list box dontrol contains a list of options from which you can choose. If the list is
longer than will fit in the list box, you can use its vertical scrollbar to scroll through

the list. Figure 4-19 shows an example of a dialog box that contains two list box
controls.

DATEVALUE
DA

DAYS30
HOUR -
MINUTE

SECOND

TIME
22 ITIMEVALUE -

Figure 4-19: Two list box controls in a dialog box.
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Drop-down boxes
Drop-down boxes are similar to list boxes, but they show only a single

option at a

time. When you click the arrow on a drop-down box, the list drops down to display

additional choices. Figure 4-20 shows an open drop-down box control.

Figure 4-20: A drop-down box control in a dialog box.

Tabbed Dialog Boxes

Many of Excel’s dialog boxes are “tabbed” dialog boxes. A tabbed dialog box includes
notebook-like tabs, each of which is associated with a different panel. When you click
a tab, the dialog box changes to display a new panel containing a new set of controls.
The Format Cells dialog box, which appears in response to the Format > Cells com-
mand, is a good example. This dialog box is shown in Figure 4-21. Noticg that it has
six tabs, which makes it functionally equivalent to six different dialog boxes.

Tabbed dialog boxes are quite convenient, because you can make sgveral changes
in a single dialog box, After you make all of your setting changes, clifk OK or

press Enter.

Figure 4-21: The Format Cells dialog box is
an example of a tabbed dialog box.




ct a tab by using the keyboard, use Ctrl+PgUp or Ctrl+PgDn, or simply press
letter of the tab that you want to activate.

This chaptér covers background information that is essential to using Excel effi-
ciently. It discusses methods to manipulate windows (which hold workbooks), as
well as several techniques used to move around within a worksheet by using the
mouse or the keyboard. It also discusses the various methods used to issue com-
cel: menus, shortcut menus, toolbar buttons, and shortcut key combi-

nations. This chapter concludes with a general discussion of dialog boxes — an ele-
on to all Windows programs.

“ + *
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Creating Maps
with Microsoft
Map

In previous chLipters, you saw how you can use a chart to
display data ip a different — and, usually, more

meaningful —way. This chapter explores the topic of mapping
and describes hgw to present geographic information in the
form of a map.

The mapping feature is not actually part of Excel. Rather, this
feature uses an ()LE server application named Microsoft Map,
which was develpped by Maplnfo Corporation. You can use
this application fo insert maps into other Microsoft Office
applications. Be¢ause the mapping application is not part of
Excel, you'll find|that the user interface is quite different from
that of Excel. WHen a map is active, Microsoft Map menus and
toolbars replace|Excel’s menus and toolbars.

Mapping: An Overview

Mapping, like chlarting, is a tool that visually presents data. '
People use maps for a variety of purposes, but the common
factor in maps ig that they work with data that has a basis in
geography. If yot classify information by state, province, or
country, chances are good that you can represent the data on

a map. For example, if your company sells its products
throughout the United States, showing the annual sales for

each state may
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A Mapping Example

Figure 17-1 shows sales data for a company, with the data categorizefl by state. To
understand this information, you would have to spend a lot of time examining the
data.

Product A Product B Combined
262 542 1] 262 542
92629 193,254 285,883
19,690 169 615 188,305
252523 183,384 435 807
3,692,809 2,135 068 5827 977
377034 149 875 526 909
327 585 425 938 753524
114,492 63,118 177 B10
1233 108,471
582,033 851978
408 371 299,702
43478 43378
128 260 43,378
0 122,238
768,711 837 597
262542 236 633
116,416 145 927
35430 86 757
96 B76 43378

Figure 17-2 shows the same data displayed in a chart. Although an improvement
over the raw-data table, this type of presentation doesn't really wojrk, because it
has too many data points. In addition, the chart doesn’t reveal any|information

about sales in a particular region.

Figure 17-3 shows the sales data presented as a map (it looks even|better in color).
This presentation uses different colors to represent various sales fanges. Looking at
the map, you can see clearly that this company performs much befter in some
regions than in others.

The map in Figure 17-3 might be even more revealing if the sales wgre represented
relative to the population of each state; that is, in per capita sales.{This population
data is available as a sample file on the Office CD (Mapstats.xIs).




-

£355b

Figure 17-2: The sales data displayed in a chart.

Figure 174 shiows the contents sheet for this workbook.
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4ngpant 400NN (5

Qt~ 40,000 5)

| L

Availabl
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create maps
data, each in
indicate the |

Figure 17-3: The sales data displayed in a map.

other accoutirements, such as labels and pin markers.

e Maps

't Map feature supports a good variety of maps and enables you to

in several different formats. A single map can display multiple sets of

a different format. For example, your map can show sales by state and
number of sales offices in each state. In addition, your map can display
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United Siaies Demograplic Data by Siate
Canada Demographic Data by Pro
Mexico Demographic Datahy 5
Eurepe Demographic Data by
United Kingdom & Republic ofIreland by Courty
Ausiralia  Austialia Demographic Daia by State

Southern Africa Sewth Africa and neighhoring countries hy

Table of Contents

Figure 17-4: The Mapstats workbook contains population statistics
that you can use in your maps.

The maps included with Microsoft Map are listed in Table 17-1. As y
this chapter, a map can be zoomed to display only a portion of it. T
can use the Europe map to zoom in on a particular region or counti

ou’ll see later in
herefore, you
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the company d
a map and clicl

Creating a

Creating a basi
you'll want to ¢

Setting U
The Microsoft

refer to Figure
as states or co

If you would likee to order additional maps or data from Maplnfo, you can contact

c map with Microsoft Map is simple. In almost all cases, however,
‘ustomize the map. This section discusses the basics of mapmaking.

rectly or visit its Web site. For information on how to do so, activate
 the Help = About command.

Map

b Your Data

ap feature works with data stored in a list format (for an example,
17-1). The first column should contain names of map regions (such
tries). The columns to the right should contain data for each area.

You can have gny number of data columns, because you select the columns to use
after the map js created. )

Creating the Map

To create a map, start by selecting the data. The selection must include one column
of area names|and at least one column of data. If the columns have descriptive
headers, include these in the selection.

Choose Insert|=> Map (or click the Map button on the Standard toolbar). Click and

drag to specify the location and size of the map or just click to create a map of the
default size. Unlike charts, maps must be embedded on a worksheet (there are no

separate mapjsheets).

Microsoft Map analyzes the area labels and generates the appropriate map. If two
or more mapg are possible (or if you've developed any custom map templates),

you'll see the[Multiple Maps Available dialog box, shown in Figure 17-5. Select the
map that youjwant to use from this list.

Figure 17-5: If multiple maps are available for
your data, you can choose from this dialog
box which map to use.
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You don't have the Insert © Map command?

Excel’s mapping feature is performed by an OLE server application
feature is not an integral part of Excel, and it may not be installed o
you don't see a Map command on the Insert menu, you need to ins
feature.

To install the mapping feature, you need to rerun Excel’s Setup pro
Microsoft Office Setup program) and specify the mapping feature. ]
displays the map using the first column of data. It also displays the
Control dialog box, discussed later in the chapter. When the map is
activated. Whenever a map is activated, Microsoft Map’s menus an
Excel’s menus and toolbars. When you click outside the map, Exce
reappears. You can reactivate a map by double-clicking it.

Setting the Map Format(s)

The mapping
n your system. If
rall the mapping

gram (or the

viicrosoft Map

Microsoft Map
created, it is

d toolbar replace

’s user interface

When a map first appears, the Microsoft Map Control dialog box isjvisible (see

Figure 17-6). Use this dialog box to change the format of the select
use the Show/Hide Map Control tool to toggle the display of this di

Figure 17-6: The Microsoft Map Control
dialog box.

ed map. You can
alog box.

By default, you create maps by using the value-shading map format. You can change

the format or display two or more formats on a single map. You u
Map Control dialog box by dragging the items in it. The top of the
displays all available data fields (which correspond to the columr
selected when you created the map). The bottom part contains th
information. Six format icons on the left determine the map formg

se the Microsoft
dialog box

s that you

le map format

t (described in

the sections that follow). You combine a map format icon with one or more data

fields by dragging the icon. For example, you can replace the defd

ult map format




icon with angther one simply by dragging the new icon over the existing one. Some
map formats|use more than one data field. In such a case, you can drag additional

data fields n¢xt to the icon.

To change options for a particular map format, either double-click the format icon
or use the Map menu and choose the menu command that is appropriate for the
format that you want to change. In either case, you get a dialog box that’s
appropriate for the map format.

sections include descriptions (and samples) of each map format
supported bly Microsoft Map.

Value shading

With this mdp format, each map region is shaded based on the value of its data.
This format is appropriate for data-quantitative information, such as sales,
population, and so on. Figure 17-7 shows an example of a map formatted with value
shading (this map is zoomed to show only part of the U.S.). In this example, the
sales are broken down into four ranges, and each sales range is associated with

different shading.

tal !3ales

8 muUtoZubuf 1)
81 w010}
3 s0to1 .20f B
] outo B0f 2

Figure 17-7} This map uses the value-shading format.

You can chiange the interval ranges in the Format Properties dialog box, shown in
Figure 17-8
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When you’re viewing a map that uses value shading, choose Map = Value Shading
Options, and Microsoft Map opens the value-shading version of the Foymat
Properties dialog box. You can specify the number of value ranges and the method
of defining the ranges — an equal number of areas in each range or an pqual spread
of values in each range. You also can select a color for the shading. The map
displays different variations of the single color that you select. You can choose the
summary function to use (SUM or AVERAGE). To hide the format from the map,
remove the check mark from the Visible check box.

Format Propei

Figure 17-8: The Value Shading Options
tab of the Format Properties dialog box.

Category shading
With the category-shading map format, each map region is colored baged on a data
value. The map legend has one entry (color) for every value of the dafa range.
Therefore, this format is appropriate for data that has a small number|of discrete
values. For example, you can use the format to identify states that have a sales
office, the number of sales reps in a country, and so on. A common usg for this
format is to identify the states that make up each sales region. Data nged not be
numeric. For example, the data can consist of text such as Yes and No

Figure 17-9 shows a map that uses category shading to identify states that met the
annual sales goal.




Ilales Uldl TACEEUed | Aell Annudl 2aigs "aodl!
s

Figure|17-9: This map uses the category-shading format.

To change the colors in the categories, use the Format Properties dialog box. Again,
when [you’re viewing a map that uses category shading, you can open this dialog
box by choosing Map = Category Shading Options. Microsoft Map displays the
categgry-shading version of the Format Options dialog box.

Dot density
The dpt-density map format displays data as a series of dots. Larger values :
translhte into more dots. The dots are placed randomly within a map region. Figure
17-10 khows an example of a map that uses the dot-density format. This map
depicts population in the UK. and Ireland. Each dot represents 100,000 people.

To change the number of units for each dot or to change the dot size, access the
Dot Density Options tab of the Format Properties dialog box, which is shown in
Figure 17-11.
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UK Standard Regions
by Population
1 Dot= 100,000

Figure 17-10: A dot-density format map, showing the population
of the UK. and Ireland.

Figure 17-11: The Dot Density Options tab
of the Format Properties dialog box.

Graduated symbol

The gradudted-symbol map format displays a symbol, the size of which is
proportional to the area’s data value, Figure 17-12 shows an example [of this format.
[ used a Wingdings font character for the symbol. To change the sympol, use the
Graduated Symbol Options dialog box. You can select a font, size, andl specific
character.




Nutheas Reygion
Potential tor Software Sales

Il
B e
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Figure 17-12

Pie chart

A graduated-symbol format map.

The pie-chatt map format requires at least two columns of data. Maps with this

format disp

y a pie chart within each map region. Figure 17-13 shows an example.

This map shows a pie chart that depicts the relative sales of three products for

each state.

‘roduct Sales
oy State

M Product A (10)
B Product u (1
[ Product ¢ (1)

Figure 17-13:

A map that uses the pie-chart format.
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To change the setting for a pie-chart format map, use the Pie Char

t Options tab of

the Format Properties dialog box, shown in Figure 17-14. This dialpg box enables

you to select a color for each pie slice. If you choose the Graduate

d option, the size

of each pie is proportional to the sum or average of the data. If yop don't use the

Graduated option, you also can set the diameter of the pies.

Figure 17-14: The Pie Chart Options tab
of the Format Properties dialog box.

Column chart

The column-chart map format is similar to the pie-chart format —except that it

displays a column chart instead of a pie chart. Figure 17-15 shows

Combining map formats
As previously mentioned, a single map can include multiple forn;%ts for different

data. You do this by stacking groups of icons and data fields in t
Control dialog box. For example, you can display sales as value s

an example.

Microsoft Map

ading and the

number of customers as a dot-density map. Each map format haslits own legend.

Overlaying multiple map types has no rules, so some experimentation usually is
necessary. Unless the map is very simple, however, you're generglly better off using
only one or two map types per map; otherwise, the map gets so g omplicated that

the original goal (making the data clear) is lost.

Figure 17-16 shows an example of a map that uses two formats. The value-shading
format shows sales broken down into four categories. The graduated-symbol

format shows the states that have a sales office.




] Prudur!A(‘l‘]}
B Prududt B (1)
[ Pradudgt € (1)

Figure 17-15: A map that uses the column-chart format.

)
.o 1400000 (13)

Salee Office

Figure Itl-lﬁ: An example of a map that uses two map formats:

the valu

Customizing Maps

After ygu create a map, you have numerous customization options from which to
choose| which are described in the following sections.

-shading format and the graduated-symbol format.
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Zooming In and Out

Microsoft Map enables you to zoom your map in and out. Zooming in|displays less
of the map and zooming out displays more of the map (or makes the gntire map
smaller). Use the Zoom Percentage of Map control on the toolbar (nojmenu
commands exist).




To zoom in, sdlect a zoom percentage greater than 100 percent. To zoom out, select
a zoom percentage less than 100 percent. Before you zoom out, you might want to
specify the pdjint that will be the center of the map (use the Center Map toolbar
button).

Repositioning a Map
You'll find that, after zooming in or out, the map may not be optimally positioned

within the map object rectangle. Use the Grabber tool to move the map image
within the map object. Just click and drag the map to reposition it.

Adding Labels

Usually, a map doesn’t have labels to identify areas. You can’t automatically add
labels to all afeas (for example, all states in the U.S.), but you can add individual
labels, one at a time. You also can insert data values that correspond to a particular
map region (such as sales for West Virginia).

Use the Labelltool to add labels or data values. When you click the Label tool, the

dialog box shpwn in Figure 17-17 appears. The option button labeled Map feature
'names refers to labels for the various parts of the map (for example, state names in
a U.S. map). When you select the Values from option, you can insert data values
from a categary in the list box. After closing the dialog box, you can drag the mouse
pointer over the map. The label or data value appears when the mouse pointer is
over a map region. Just click to place the label or data value and then repeat this
procedure fort each map label or data value that you want to add. Figure 17-18

Figure 17-17: [The Map Labels dialog box
enables you tq add labels or data values to
your map.

To move a label, click and drag it to a new location. You can change the font, size,
or color of a |abel by double-clicking it. Stretching the label (by dragging a border)
also makes the font larger or smaller.
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Sales by State

Mebraska

Missouri

- 15608

Figure 17-18: This map has labels and data values.

Adding Text

Besides the labels described in the preceding section, you can add free
to your map by using the Text tool. Just click the Text tool, click the arg
where you want to add text, and enter your text. You can manipulate te
way that you manipulate labels.

If you don't like the fact that a map title always has a border around it (
border can’t be removed), delete the title and create your own with the

Adding Pins to a Map

floating text
ra of the map
xt the same

and the
Text tool.

In some cases, you may want to add one or more identifier icons to yo
is similar in concept to inserting pins in a wall map to identify various

Clicking the Custom Pin Map tool displays a dialog box that asks you t
name for a custom pin map (or choose an existing pin map). Enter a d
label; you'll be able to bring these same pins into another map (of the
later. For example, if you're identifying sales office locations, you can t
same pins to another map.

When you close the dialog box, the mouse pointer changes to a pushpi
place these pins anywhere in your map. When you click the map to pl

r map. This
laces.

enter a
scriptive

ame type)
en add the

. You can
e a pin, you

also can enter descriptive text. Double-clicking a pin enables you to change the
symbol that is used to something other than a pin. Figure 17-19 shows a map with

pins added to it.




Store Locations

ancisco

Figure
specific

7-19: This map has pins to identify
locations.

Modifying the Legend

You haye quite a bit of control over the legend in a map. Note that a map displays a
separate legend for each map format that it uses. To modify a legend, double-click it

to see

he dialog box shown in Figure 17-20.

by Productd

Figure 17-20: The Legend Options tab of
the Format Properties dialog box.
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You can display a legend in a compact format or in its normal format.rA

format takes up less space, but it doesn’t give many details. You also ¢
the legend’s title and subtitle (and enter a different title for a compact

labels that are used in the legend.

To make other changes to the legend —such as changing the number
that are used — select the appropriate menu item on the Map menu. Fo
to change the number of ranges that are used in a value-shading map f
the Map = Value Shading Options command.

Adding and Removing Features

You can add or remove certain features of a map. When you select Map

you see the Map Features dialog box (see Figure 17-21), which lists all awvailable

features for the selected map. To turn on a feature, place a check mark

turn off a feature, remove the check mark. The features available vary W

that you're using. If a feature doesn’t appear in the list, you can add it b
the Add button.

Figure 17-21: The Map Features dialog box.

Figure 17-22 shows a North America map with some features added (ma
major highways, and world oceans) and some features removed (Canad
Mexico).

Table 17-2 lists the features available for each map. You can, however, g
from different maps —add world oceans to a North America map, for ej

In some cases, you may want your map to display only specific areas. F|
if your company does business in Missouri, Illinois, Kansas, and Nebrag

create a map that shows only these four states. Create a map that incluges these

states and then remove all features from the map by using the Map => F¢
command. The map then shows only those areas that have data. Figure
an example.

o

Other buttons enable you to adjust the font (mcludmg size and color) a

Z{data ranges

compact
change
legend).
nd edit the

example,
mat, select

> Features,

hext to it. To
rith the map
v clicking

jor cities,
a and

dd features
rample.
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ka, you can

ratures
17-23 shows




